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1. Assignment Editor
Introduction
The complexity of today’s FPGA designs is compounded by the increasing density 
and associated pin counts of current FPGAs. It requires you to make a large number of 
pin assignments that include the pin locations and I/O standards to successfully 
implement a complex design in the latest generation of FPGAs.

To facilitate the process of entering these assignments, Altera has developed an 
intuitive, spreadsheet interface called the Assignment Editor (sometimes referred to 
as the editor in this chapter). The Assignment Editor is designed to make the process 
of creating, changing, and managing a large number of assignments as easy as 
possible.

This chapter discusses the following topics:

■ “Overview of the Assignment Editor”

■ “User Interface” on page 1–3

■ “Navigating the Assignment Editor Spreadsheet” on page 1–5

■ “Exporting and Importing Assignments” on page 1–7

■ “Creating Timing Constraints Using the Assignment Editor” on page 1–9

■ “Tcl Interface” on page 1–10

■ “Probing to Source Design Files and Other Quartus II Windows” on page 1–10

Overview of the Assignment Editor
You can use the Assignment Editor throughout the design cycle, for making either 
timing or logic assignments. Altera recommends making assignments using the 
Assignment Editor to help reduce mistakes while making assignments throughout the 
design cycle. With the editor’s dynamic syntax-checking capability, illegal 
assignments or incorrect settings can be avoided. You can also use the Assignment 
Editor to view, filter, and sort assignments based on node name or assignment type.

1 Even though the Assignment Editor allows you to make pin assignments, Altera 
recommends using the Pin Planner instead. You can use the Assignment Editor to 
view and verify the pin assignments that you have made.

The Assignment Editor is a resizable window. This scalability makes it easy to view or 
edit your assignments right next to your design files. To open the Assignment Editor, 
click the Assignment Editor icon in the toolbar, or on the Assignments menu, click 
Assignment Editor.

1 You can also launch the Assignment Editor by pressing Ctrl+Shift+A in the 
Quartus® II software.
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Overview of the Assignment Editor
The assignments made in the Assignment Editor are saved in the Quartus II Settings 
File (.qsf), which is located in the project directory. A separate .qsf file exists for each 
individual revision. Every new assignment is placed on a new line at the end of the 
.qsf file. Refer to the Quartus II Help for the syntax of the .qsf file. Refer to the 
“Viewing and Saving Assignments in the Assignment Editor” section for more details 
about how Assignment Editor handles your assignments.

Every time an assignment is created or updated, the Quartus II software displays the 
equivalent Tcl command in the System tab of the Messages window. You can use the 
displayed messages as references when making assignments using Tcl commands.

For information about exporting your assignments to a Tcl file, refer to “Tcl Interface” 
on page 1–10.

Dynamic Syntax Checking
As you enter assignments, the Assignment Editor checks for basic legality and syntax. 
This checking is not as thorough as the checks performed during compilation, but it 
rejects incorrect settings.

1 If there are incomplete assignments when you click Save on the File menu, a prompt 
gives you the choice to either save the file and lose incomplete assignments or cancel 
the save operation.

The legality status of the assignments is color coded. The color of the text in each row 
indicates if the assignment is incomplete, disabled, non-editable, or contains errors or 
warnings (Table 1–1). To customize the colors used in the Assignment Editor, on the 
Tools menu, click Options.

Viewing and Saving Assignments in the Assignment Editor
Although the Assignment Editor is the most common method of entering and 
modifying assignments, there are other methods you can use to make and edit 
assignments. For this reason, you can refresh the Assignment Editor after you add, 
remove, or change an assignment outside the Assignment Editor.

By default, all assignments made in the Quartus II software are first stored in memory, 
then to the .qsf file on the disk after you start a processing task, or if you save or close 
your project. Saving assignments to memory avoids reading and writing to your disk 
drive and improves the performance of the software.

After making assignments in the Assignment Editor, on the File menu, click Save to 
save your assignments and update the .qsf file.

Table 1–1. Description of the Color Codes in the Spreadsheet

Text Color Description

Green A new assignment can be created

Dark Yellow The assignment contains warnings, such as unknown node name

Dark Red The assignment is incomplete

Red The assignment has an error, such as an illegal value

Light Gray The assignment is disabled or turned off

Gray The assignment is non-editable or read-only
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation



Chapter 1: Assignment Editor 1–3
User Interface
Starting with the Quartus II software version 5.1, you can force all assignments to be 
written to a disk drive. On the Tools menu, click Options. In the Options dialog box, 
open the Processing page and turn off Update assignments to disk during design 
processing only.

f For more information about how the Quartus II software writes to the .qsf file, refer to 
the Managing Quartus II Projects chapter in volume 2 of the Quartus II Handbook.

You can refresh the Assignment Editor window by clicking Refresh on the View 
menu. If you make an assignment using the Tcl console, Pin Planner, or directly 
modifying the .qsf file outside the Assignment Editor, you must click Refresh to 
update the Assignment Editor spreadsheet.

1 If the .qsf file is edited while the project is open, on the File menu, click Save Project 
to ensure that you are editing the latest .qsf file.

Each time the Assignment Editor is refreshed, the following message is displayed in 
the System tab of the Messages window:

Info: Assignments reloaded -- assignments updated outside Assignment 
Editor

User Interface
The Assignment Editor window consists of four bars and a spreadsheet (Figure 1–1). 
The spreadsheet is where you view and edit the assignments. You can use the bars to 
filter, edit, or get detailed information about the assignments.

You can hide all four bars in the View menu if desired, or you can collapse all the bars 
for a better view of the spreadsheet. Table 1–2 provides a brief description of each bar.

Figure 1–1. The Assignment Editor Window
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User Interface
Category Bar
The Category bar lists all assignment categories available for the selected device. You 
can use the Category bar to select a particular type of assignment and filter out all 
other assignments, making the spreadsheet show only the applicable assignments. 
For example, to view all tSU (setup time) assignments in your project, select tsu in the 
Category list. If you select All in the Category list, the Assignment Editor displays all 
assignments.

When you collapse the Category bar, three buttons are displayed that allow you to 
select from various preset categories (Figure 1–2). For example, clicking the Timing 
button changes the spreadsheet to show only the timing-related assignments of your 
project.

Node Filter Bar
The Node Filter bar is used when you want the spreadsheet to show only 
assignments for specific nodes based on the list of selected node filters. The bar 
provides flexibility in how you view and make your settings.

For example, when Show assignments for specific nodes is turned on, the 
spreadsheet shows only assignments for nodes that match the selected node filter. You 
can create a new node filter by using the Node Finder to select a node name or by 
typing the node name. The node name filter can be a node name or assignment group, 
and can include wildcard symbols (* and ?). The wildcards symbols are used to filter 
for a selection of nodes with only one entry in the Node Filter. For more information 
about wildcard symbols and assignment groups, refer to “Navigating the Assignment 
Editor Spreadsheet” on page 1–5.

Information Bar
The Information bar provides a brief description of the currently selected cell and 
what information you should enter into the cell. For example, the Information bar 
describes whether a cell should contain a node name or a number value.

Edit Bar
The Edit bar is an efficient way to enter a value into one or more spreadsheet cells. To 
change the contents of multiple cells at the same time, select the cells in the 
spreadsheet, then type or choose the new value in the Edit field in the Edit bar.

Table 1–2. Assignment Editor Bar Descriptions

Bar Name Description

Category Lists the types of available assignments

Node Filter Lists a selection of design nodes to be viewed or assigned

Information Displays a description of the selected assignment

Edit Allows you to edit the text in the selected cell(s)

Figure 1–2. Collapsed Category Bar 
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Navigating the Assignment Editor Spreadsheet
Assignment Spreadsheet
The spreadsheet displays the assignments of your project. You can sort columns, use 
pull-down list boxes to view available options, and copy and paste multiple cells into 
the Assignment Editor. Refer to “Entering Values into the Spreadsheet” for details 
about ways to make assignments in the spreadsheet.

When you enter an assignment, the font color of the row changes to indicate the status 
of the assignment. For more information, refer to “Dynamic Syntax Checking” on 
page 1–2.

The spreadsheet also supports customizable columns that allow you to show, hide, 
and arrange columns. For more information, refer to “Customizing the Spreadsheet 
Columns” on page 1–7.

Toolbar
The Assignment Editor’s toolbar contains shortcut buttons for easy access to the 
editor’s features. Figure 1–3 describes the buttons in the toolbar.

Navigating the Assignment Editor Spreadsheet
This section describes methods for navigating through the spreadsheet.

Entering Values into the Spreadsheet
There are many ways to select or enter nodes into the spreadsheet, including the Node 
Finder, the Node Filter bar, the Edit bar, or by directly typing the node name into a cell 
in the spreadsheet.

Figure 1–3. Description of Icons in the Toolbar

Detach the Assignment Editor window

Delete value in selected cells

Remove selected rows from the spreadsheet

Refresh the spreadsheet

Full screen view

Open the Customize Columns dialog box

Show all assignable pin numbers

Show all known pin names

Hide or show Category bar

Hide or show Node Filter bar

Hide or show Information bar

Hide or show Edit bar

Move cursor to the last row for new entry
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Navigating the Assignment Editor Spreadsheet
1 To open the Node Finder, click Node Finder in the Edit menu, or right-click any cell in 
the spreadsheet or the Node Filter bar and click Node Finder. Alternatively, you can 
click Node Finder in the pull-down menu of the To and From columns in the 
spreadsheet.

A node type icon is shown beside each node name and filter to identify its type. 
Table 1–3 lists the different ions and describes its type.

Wildcards
To simplify the tasks of making many node assignments, the Quartus II software 
accepts the * and ? wildcard characters. Use these wildcard characters to reduce the 
number of individual assignments you need to make for your design.

The * wildcard character matches any string. For example, given an assignment made 
to a node specified as reg*, the Assignment Editor applies the assignment to all 
design nodes that match the prefix reg with none, one, or several characters 
following the prefix, such as reg, reg1, reg[2], regbank, and reg12bank.

The ? wildcard character matches any single character. For example, given an 
assignment made to a node specified as reg?, the Assignment Editor applies the 
assignment to all design nodes that match the prefix reg and any single character 
following, such as reg1, rega, and reg4.

Table 1–3. Node Type Icons 

Node Type Icon Description

Input pin

Output pin

Bidirectional pin

Register

Combinational logic

Assignment group

Node name or filter that contains wildcard symbols

Instance

Missing information—probably caused by incorrect node name, or 
Analysis and Synthesis has not been performed
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Exporting and Importing Assignments
1 All assignments that support wildcards are shown in the pull-down list under the 
Assignment Name column of the Assignment Editor with “(Accepts 
wildcards/groups)” displayed beside it.

Assignment Groups
An assignment group, also known as a time group, is a collection of design nodes 
grouped together and represented as a single unit for the purpose of making 
assignments to the collection. Using assignment groups with the Assignment Editor 
provides the flexibility required for making complex assignments to a large number of 
nodes. You can also exclude specific nodes, wildcards, and assignments from an 
assignment group.

To create an assignment group, on the Assignments menu, click Assignment (Time) 
Groups. The Assignment Groups dialog box appears. You can add or delete 
members of each assignment group using wildcards in the Node Finder.

f For more information about using Assignment Groups for timing analysis, refer to the 
Quartus II Classic Timing Analyzer chapter in volume 3 of the Quartus II Handbook.

Customizing the Spreadsheet Columns
To provide more control over the display of information in the spreadsheet, the 
Assignment Editor supports customizable columns.

You can move columns, sort them in ascending or descending order, show or hide 
individual columns, and align the content of the column left, center, or right for 
improved readability.

When the Quartus II software starts for the first time, you see a pre-selected set of 
columns. For example, when the Quartus II software is first started, the Comment 
column is hidden. To show or hide any of the available columns, on the View menu, 
click Customize Columns. When you restart the Quartus II software, your column 
settings are maintained.

You can use the Comments column to document the purpose of an assignment, or to 
explain why you applied a timing or logic constraint. You can use the Enabled 
column to disable any assignment without deleting it. This feature is useful when 
performing multiple compilations with different timing constraints or logic 
optimizations.

Exporting and Importing Assignments
Designs that use the LogicLock™ hierarchical design methodology use the Import 
Assignments command to import assignments into the current project. You can also 
use the Export Assignments command to save all the assignments in your project to a 
file to be used for archiving or to transfer assignments from one project to another.

On the Assignments menu, click Export Assignments or Import Assignments to do 
the following:

■ Export your Quartus II assignments to a .qsf file.
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Exporting and Importing Assignments
■ Import assignments from a Quartus II Entity Settings File (.esf), a MAX+PLUS® II 
Assignment and Configuration File (.acf), a Synopsys Design Constraint (.sdc) file, 
a text file (.txt), or a Comma Separated Value (.csv) file.

In addition to the Export Assignments and Import Assignments dialog boxes, the 
Export command on the File menu allows you to export your assignments to a .tcl file 
or a .csv file.

You can use these file formats for many different aspects of your project. For example, 
you can use a .csv file for documentation purposes or to transfer pin-related 
information to board layout tools. The .tcl file makes it easy to apply assignments in a 
scripted design flow. The LogicLock design flow uses the .qsf file to transfer your 
LogicLock region settings.

Exporting Assignments
You can use the Export Assignments dialog box to export your Quartus II software 
assignments into a .qsf file, generate a node-level netlist file, and export 
back-annotated routing information as a Routing Constraints File (.rcf). See 
Figure 1–4.

On the Assignments menu, click Export Assignments to open the Export 
Assignments dialog box. The LogicLock design flow also uses this dialog box to 
export LogicLock regions.

f For more information about using the Export Assignments dialog box to export 
LogicLock regions, refer to the Analyzing and Optimizing the Design Floorplan chapter 
in volume 2 of the Quartus II Handbook.

On the File menu, click Export to export all assignments to a .tcl file or export a set of 
assignments to a .csv file. When you export assignments to a .tcl file, only user-created 
assignments are written to the Tcl script file; default assignments are not exported.

When assignments are exported to a .csv file, only the assignments displayed in the 
current view of the Assignment Editor are exported.

Figure 1–4. Export Assignments Dialog Box
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Creating Timing Constraints Using the Assignment Editor
Importing Assignments
The Import Assignments dialog box allows you to import Quartus II assignments 
from a .qsf file, an .esf file, an .acf file, or a .csv file (Figure 1–5).

To import assignments from any of the supported assignment files, perform the 
following steps:

1. On the Assignments menu, click Import Assignments. The Import Assignments 
dialog box appears (Figure 1–5).

2. In the File name text-entry box, type the file name or browse to the assignment 
file. The Select File dialog box appears.

3. In the Select File dialog box, select the file and click Open.

4. Click OK.

1 When you import a .csv file, the first uncommented row of the file must be in the 
exact format as it was when exported.

You can create a backup copy of your assignments before importing new assignments 
by turning on the Copy existing assignments into <revision name>.qsf.bak before 
importing option.

When importing assignments from a file, you can choose which assignment categories 
to import by following these steps:

1. Click Categories in the Import Assignments dialog box.

2. Turn on the categories you want to import from the Assignment categories list.

To select specific types of assignments to import, click Advanced in the Import 
Assignments dialog box. The Advanced Import Settings dialog box appears. You can 
choose to import instance, entity, or global assignments and select various assignment 
types to import.

f For more information about these options, refer to the Quartus II Help.

Creating Timing Constraints Using the Assignment Editor
Accurate timing constraints guide the place-and-route engine in the Quartus II 
software to help optimize your design into the FPGA. After completing a 
place-and-route, perform a static timing analysis using the Quartus II Classic Timing 
Analyzer or the Quartus II TimeQuest Timing Analyzer to analyze slack and critical 
paths in your design.

Figure 1–5. Import Assignments Dialog Box
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Tcl Interface
If you are using the Quartus II Classic Timing Analyzer, create timing constraints 
using the Assignment Editor. In the Assignment Editor, select Timing in the Category 
list to show all timing-related settings and make the desired timing assignments in the 
editor’s spreadsheet.

f For more information about the Quartus II Classic Timing Analyzer, refer to the 
Quartus II Classic Timing Analyzer chapter in volume 3 of the Quartus II Handbook.

If you are using the Quartus II TimeQuest Timing Analyzer, the TimeQuest Timing 
Analyzer uses timing assignments from a Synopsys Design Constraint (.sdc) file. 
Therefore, you must convert assignments from the .qsf format to the .sdc format 
before you can proceed with the timing analysis.

f For information about converting the timing assignments in your .qsf file to an .sdc 
file, refer to the Switching to the Quartus II TimeQuest Timing Analyzer chapter in 
volume 3 of the Quartus II Handbook.

Tcl Interface
Whether you use the Assignment Editor or another feature to create your design 
assignments, you can export them to a Tcl (.tcl) file. You can then use the .tcl file to 
reapply the settings or to archive your assignments. On the File menu, click Export to 
export your saved assignments to a .tcl file.

You can also generate a .tcl file that sets up your project and applies all the 
assignments to it. On the Project menu, click Generate Tcl File for Project to generate 
the file.

In addition, as you use the Assignment Editor to enter assignments, the equivalent Tcl 
commands are shown in the System tab of the Messages window. You can reference 
these Tcl commands to create a customized .tcl file. To copy a Tcl command from the 
System tab of the Messages window, right-click the message and click Copy.

f For more information about Tcl scripting with the Quartus II software, refer to the Tcl 
Scripting chapter in volume 2 of the Quartus II Handbook.

Probing to Source Design Files and Other Quartus II Windows
The Assignment Editor lets you cross-probe from the viewer to the source design file 
and to other windows within the Quartus II software. You can select a cell in the 
Assignment Editor spreadsheet and locate the corresponding item in another 
applicable Quartus II software window. To locate an item from the editor in another 
window, right-click the items of interest in the spreadsheet, point to Locate, and click 
the appropriate command. The following commands are available: 

■ Assignment Editor

■ Pin Planner

■ Timing Closure Floorplan

■ Chip Planner (Floorplan & Chip Editor)

■ Resource Property Editor
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Conclusion
■ Technology Map Viewer

■ RTL Viewer

■ Design File

Probing to the Assignment Editor from Other Quartus II Windows
You can cross-probe to the Assignment Editor from other windows within the 
Quartus II software. You can select one or more nodes or nets in another window and 
locate them in the Assignment Editor spreadsheet. This is useful when you want to 
see all assignments related to specific nodes.

You can locate nodes in the Assignment Editor from all windows within the 
Quartus II software. To locate assignments related to an element in the editor from 
other Quartus II windows, select the node or nodes in the appropriate window. For 
example, select an entity in the Entity list on the Hierarchy tab in the Project 
Navigator, or select nodes in the Timing Closure Floorplan. Next, right-click the 
selected object, point to Locate, and click Locate in Assignment Editor. The 
Assignment Editor opens, or it is brought to the foreground if it is already open.

Conclusion
As FPGAs continue to increase in density and pin count, it is essential to be able to 
quickly create and view design assignments. The Assignment Editor provides an 
intuitive and effective way of making assignments. With the spreadsheet interface 
and the Category, Node Filter, Information, and Edit bars, the Assignment Editor 
provides an efficient assignment entry solution for FPGA designers.

Referenced Documents
This chapter references the following documents:

■ Analyzing and Optimizing the Design Floorplan chapter in volume 2 of the Quartus II 
Handbook

■ Managing Quartus II Projects chapter in volume 2 of the Quartus II Handbook

■ Quartus II Classic Timing Analyzer chapter in volume 3 of the Quartus II Handbook

■ Switching to the Quartus II TimeQuest Timing Analyzer chapter in volume 3 of the 
Quartus II Handbook

■ Tcl Scripting chapter in volume 2 of the Quartus II Handbook
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Document Revision History
Document Revision History
Table 1–4 shows the revision history for this chapter.

f For previous versions of the Quartus II Handbook, refer to the Quartus II Handbook 
Archive.

Table 1–4. Document Revision History 

Date and Document 
Version Changes Made Summary of Changes

March 2009
v9.0

■ Revised and reorganized the entire chapter.

■ Added section “Probing to Source Design Files and Other 
Quartus II Windows” on page 1–10.

■ Added description of node type icons (Table 1–3).

■ Added explanation of wildcard characters.

Updated for the Quartus II 
software version 9.0 release.

November 2008
v8.1

Changed to 8½” × 11” page size. No change to content. Updated for the Quartus II 
software version 8.1.

May 2008
v8.0

Updated Quartus II software 8.0 revision and date. Updated references.
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation

http://www.altera.com/literature/lit-qts_archive.jsp
http://www.altera.com/literature/lit-qts_archive.jsp


© March 2009 Altera Corporation

QII52002-9.0.0
2. Command-Line Scripting
Introduction
FPGA design software that easily integrates into your design flow saves time and 
improves productivity. The Altera® Quartus® II software provides you with a 
command-line executable for each step of the FPGA design flow to make the design 
process customizable and flexible.

The benefits provided by command-line executables include:

■ Command-line control over each step of the design flow

■ Easy integration with scripted design flows including makefiles

■ Reduced memory requirements

■ Improved performance

The command-line executables are also completely compatible with the Quartus II 
GUI, allowing you to use the exact combination of tools that you prefer.

This chapter describes how to take advantage of Quartus II command-line 
executables, and provides several examples of scripts that automate different 
segments of the FPGA design flow, including the following topics:

■ “The Benefits of Command-Line Executables”

■ “Introductory Example” on page 2–2

■ “Command-Line Executables” on page 2–3

■ “Design Flow” on page 2–9

■ “The MegaWizard Plug-In Manager” on page 2–13

■ “Command-Line Scripting Examples” on page 2–19

The Benefits of Command-Line Executables
The Quartus II command-line executables provide command-line control over each 
step of the design flow. Each executable includes options to control commonly used 
software settings. Each executable also provides detailed, built-in help describing its 
function, available options, and settings.

Command-line executables allow for easy integration with scripted design flows. You 
can easily create scripts in any language with a series of commands. These scripts can 
be batch-processed, allowing for integration with distributed computing in server 
farms. You can also integrate the Quartus II command-line executables in 
makefile-based design flows. All of these features enhance the ease of integration 
between the Quartus II software and other EDA synthesis, simulation, and 
verification software.
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Introductory Example
Command-line executables add integration and scripting flexibility without 
sacrificing the ease-of-use of the Quartus II GUI. You can use the Quartus II GUI and 
command-line executables at different stages in the design flow. For example, you 
might use the Quartus II GUI to edit the floorplan for the design, use the 
command-line executables to perform place-and-route, and return to the Quartus II 
GUI to perform debugging with the Chip Editor.

Command-line executables reduce the amount of memory required during each step 
in the design flow. Because each executable targets only one step in the design flow, it 
is relatively compact, both in file size and the amount of memory used when running. 
This memory reduction improves performance, and is particularly beneficial in 
design environments where computer networks or workstations are heavily used 
with reduced memory.

Introductory Example
The following introduction to design flow with command-line executables shows 
how to create a project, fit the design, perform timing analysis, and generate 
programming files.

The tutorial design included with the Quartus II software is used to demonstrate this 
functionality. If installed, the tutorial design is found in the <Quartus II 
directory>/qdesigns/fir_filter directory. 

Before making changes, copy the tutorial directory and type the four commands 
shown in Example 2–1 at a command prompt in the new project directory:

1 The <Quartus II directory>/quartus/bin directory must be in your PATH environment 
variable.

The quartus_map filtref --source=filtref.bdf --family=CYCLONE 
command creates a new Quartus II project called filtref with the filtref.bdf file as the 
top-level file. It targets the Cyclone® device family and performs logic synthesis and 
technology mapping on the design files.

The quartus_fit filtref --part=EP1C12Q240C6 --fmax=80MHz 
--tsu=8ns command performs fitting on the filtref project. This command specifies 
an EP1C12Q240C6 device and the Fitter attempts to meet a global fMAX requirement of 
80 MHz and a global tSU requirement of 8 ns.

The quartus_asm filtref command creates programming files for the filtref 
project.

The quartus_tan filtref command performs timing analysis on the filtref 
project to determine whether the design meets the timing requirements that were 
specified to the quartus_fit executable.

Example 2–1. Introductory Example

quartus_map filtref --source=filtref.bdf --family=CYCLONE r
quartus_fit filtref --part=EP1C12F256C6 --fmax=80MHz --tsu=8ns r
quartus_asm filtref r 
quartus_tan filtref r 
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Command-Line Executables
You can put the four commands from Example 2–1 into a batch file or script file, and 
run them. For example, you can create a simple UNIX shell script called compile.sh, 
which includes the code shown in Example 2–2.

Edit the script as necessary and compile your project.

Command-Line Executables
Table 2–1 lists the command-line executables and their respective descriptions.

Example 2–2. UNIX Shell Script: compile.sh

#!/bin/sh
PROJECT=filtref
TOP_LEVEL_FILE=filtref.bdf
FAMILY=Cyclone
PART=EP1C12F256C6
FMAX=80MHz
--TSU=8ns
quartus_map $PROJECT --source=$TOP_LEVEL_FILE --family=$FAMILY
quartus_fit $PROJECT --part=$PART --fmax=$FMAX --tsu=$TSU
quartus_asm $PROJECT
quartus_tan $PROJECT

Table 2–1. Quartus II Command-Line Executables and Descriptions (Part 1 of 3)

Executable Description

Analysis and Synthesis 
quartus_map

Quartus II Analysis and Synthesis builds a single project database that integrates all the 
design files in a design entity or project hierarchy, performs logic synthesis to minimize the 
logic of the design, and performs technology mapping to implement the design logic using 
device resources such as logic elements.

Fitter
quartus_fit

The Quartus II Fitter performs place-and-route by fitting the logic of a design into a device. 
The Fitter selects appropriate interconnection paths, pin assignments, and logic cell 
assignments. 

Quartus II Analysis and Synthesis must be run successfully before running the Fitter.

Assembler
quartus_asm

The Quartus II Assembler generates a device programming image, in the form of one or 
more of the following from a successful fit (that is, place-and-route).

■ Programmer Object Files (.pof)

■ SRAM Object Files (.sof)

■ Hexadecimal (Intel-Format) Output Files (.hexout)

■ Tabular Text Files (.ttf)

■ Raw Binary Files (.rbf)

The .pof and .sof files are then processed by the Quartus II Programmer and downloaded to 
the device with the MasterBlasterTM or the ByteBlasterTM II download cable, or the Altera 
Programming Unit (APU). The Hexadecimal (Intel-Format) Output Files, Tabular Text Files, 
and Raw Binary Files can be used by other programming hardware manufacturers that 
provide support for Altera devices. 

The Quartus II Fitter must be run successfully before running the Assembler.
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Classic Timing Analyzer
quartus_tan

The Quartus II Classic Timing Analyzer computes delays for the given design and device, and 
annotates them on the netlist. Then, the Classic Timing Analyzer performs timing analysis, 
allowing you to analyze the performance of all logic in your design. The quartus_tan 
executable includes Tcl support. 

Quartus II Analysis and Synthesis or the Fitter must be run successfully before running the 
Classic Timing Analyzer.

TimeQuest Timing Analyzer
quartus_sta

The Quartus II TimeQuest Timing Analyzer computes delays for the given design and device, 
and annotates them on the netlist. Next, the TimeQuest Timing Analyzer performs timing 
analysis, allowing you to analyze the performance of all logic in your design. The 
quartus_sta executable includes Tcl support and SDC support.

Quartus II Analysis and Synthesis or the Fitter must be run successfully before running the 
TimeQuest Timing Analyzer.

Design Assistant
quartus_drc

The Quartus II Design Assistant checks the reliability of a design based on a set of design 
rules. The Design Assistant is especially useful for checking the reliability of a design before 
converting the design for HardCopy® devices. The Design Assistant supports designs that 
target any Altera device supported by the Quartus II software, except MAX® 3000 and 
MAX 7000 devices.

Quartus II Analysis and Synthesis or the Fitter must be run successfully before running the 
Design Assistant.

Compiler Database Interface
quartus_cdb

The Quartus II Compiler Database Interface generates incremental netlists for use with 
LogicLockTM back-annotation, or back-annotates device and resource assignments to 
preserve the fit for future compilations. The quartus_cdb executable includes Tcl 
support.

Analysis and Synthesis must be run successfully before running the Compiler Database 
Interface.

EDA Netlist Writer
quartus_eda

The Quartus II EDA Netlist Writer generates netlist and other output files for use with other 
EDA tools. 

Analysis and Synthesis, the Fitter, or Timing Analyzer must be run successfully before 
running the EDA Netlist Writer, depending on the arguments used.

Simulator
quartus_sim

The Quartus II Simulator tests and debugs the logical operation and internal timing of the 
design entities in a project. The Simulator can perform two types of simulation: functional 
simulation and timing simulation. The quartus_sim executable includes Tcl support. 

Quartus II Analysis and Synthesis must be run successfully before running a functional 
simulation. 

The Timing Analyzer must be run successfully before running a timing simulation.

Power Analyzer
quartus_pow

The Quartus II PowerPlay Power Analyzer estimates the thermal dynamic power and the 
thermal static power consumed by the design. For newer families such as Stratix® II and 
MAX II, the power drawn from each power supply is also estimated.

Quartus II Analysis and Synthesis or the Fitter must be run successfully before running the 
PowerPlay Power Analyzer.

Table 2–1. Quartus II Command-Line Executables and Descriptions (Part 2 of 3)

Executable Description
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Command-Line Scripting Help
Help on command-line executables is available through different methods. You can 
access help built in to the executables with command-line options. You can use the 
Quartus II Command-Line and Tcl API Help browser for an easy graphical view of 
the help information. Additionally, you can refer to the Quartus II Scripting Reference 
Manual on the Quartus II literature page of Altera’s website, which has the same 
information in PDF format.

To use the Quartus II Command-Line and Tcl API Help browser, type the following: 

quartus_sh --qhelp r
This command starts the Quartus II Command-Line and Tcl API Help browser, a 
viewer for information about the Quartus II Command-Line executables and Tcl API 
(Figure 2–1).

Use the -h option with any of the Quartus II Command-Line executables to get a 
description and list of supported options. Use the --help=<option name> option for 
detailed information about each option.

Programmer
quartus_pgm

The Quartus II Programmer programs Altera devices. The Programmer uses one of the 
supported file formats: 

■ .pof file

■ .sof file

■ Jam File (.jam)

■ Jam Byte-Code File (.jbc)

Make sure you specify a valid programming mode, programming cable, and operation for a 
specified device.

Convert Programming File
quartus_cpf

The Quartus II Convert Programming File module converts one programing file format to a 
different possible format.

Make sure you specify valid options and an input programming file to generate the new 
requested programming file format.

Quartus Shell
quartus_sh

The Quartus II Shell acts as a simple Quartus II Tcl interpreter. The Shell has a smaller 
memory footprint than the other command-line executables that support Tcl. The Shell may 
be started as an interactive Tcl interpreter (shell), used to run a Tcl script, or used as a quick 
Tcl command evaluator, evaluating the remaining command-line arguments as one or more 
Tcl commands. 

TimeQuest Timing Analyzer 
GUI
quartus_staw

This executable opens the Quartus II TimeQuest Timing Analyzer GUI. This is helpful because 
you don’t have to open the entire Quartus II GUI for certain operations.

Programmer GUI
quartus_pgmw

This executable opens up the programmer—a GUI to the quartus_pgm executable. This 
is helpful because users don’t have to open the entire Quartus II GUI for certain operations

Table 2–1. Quartus II Command-Line Executables and Descriptions (Part 3 of 3)

Executable Description
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Command-Line Option Details
Command-line options are provided for many common global project settings and 
performing common tasks. You can use either of two methods to make assignments to 
an individual entity. If the project exists, open the project in the Quartus II GUI, 
change the assignment, and close the project. The changed assignment is updated in 
the Quartus II Settings File. Any command-line executables that are run after this 
update use the updated assignment. Refer to “Option Precedence” on page 2–7 for 
more information. You can also make assignments using the Quartus II Tcl scripting 
API. If you want to completely script the creation of a Quartus II project, choose this 
method.

f Refer to the Tcl Scripting chapter in volume 2 of the Quartus II Handbook. Scripting 
information for all Quartus II project settings and assignments is located in the QSF 
Reference Manual.

Figure 2–1. Quartus II Command-Line and Tcl API Help Browser
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Option Precedence
If you use command-line executables, you should be aware of the precedence of 
various project assignments and how to control the precedence. Assignments for a 
particular project exist in the Quartus II Settings File for the project. Assignments for a 
project can also be made with command-line options. Project assignments are 
reflected in compiler database files that hold intermediate compilation results and 
reflect assignments made in the previous project compilation.

All command-line options override any conflicting assignments found in the 
Quartus II Settings File or the compiler database files. There are two command-line 
options to specify whether Quartus II Settings File or compiler database files take 
precedence for any assignments not specified as command-line options.

1 Any assignment not specified as a command-line option or found in the Quartus II 
Settings File or compiler database file is set to its default value.

The file precedence command-line options are --read_settings_files and 
--write_settings_files. 

By default, the --read_settings_files and --write_settings_files 
options are turned on. Turning on the --read_settings_files option causes a 
command-line executable to read assignments from the Quartus II Settings File 
instead of from the compiler database files. Turning on the 
--write_settings_files option causes a command-line executable to update the 
Quartus II Settings File to reflect any specified options, as happens when you close a 
project in the Quartus II GUI.

If you use command-line executables, you should be aware of the precedence of 
various project assignments and how to control the precedence. Assignments for a 
particular project can exist in three places:

■ The Quartus II Settings File for the project

■ The result of the last compilation, in the \db directory, reflects the assignments 
that existed when the project was compiled.

■ Command-line options

Table 2–2 lists the precedence for reading assignments depending on the value of the 
--read_settings_files option.

Table 2–2. Precedence for Reading Assignments

Option Specified Precedence for Reading Assignments

--read_settings_files = on

(Default)

1. Command-line options

2. Quartus II Settings File 

3. Project database (db directory, if it exists)

4. Quartus II software defaults

--read_settings_files = off 1.  Command-line options

2. Project database (db directory, if it exists)

3. Quartus II software defaults
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Table 2–3 lists the locations to which assignments are written, depending on the value 
of the --write_settings_files command-line option.

Example 2–3 assumes that a project named fir_filter exists, and that the analysis and 
synthesis step has been performed (using the quartus_map executable).

The first command, quartus_fit fir_filter --fmax=80MHz, runs the 
quartus_fit executable and specifies a global fMAX requirement of 80 MHz.

The second command, quartus_tan fir_filter, runs Quartus II timing analysis 
for the results of the previous fit.

The third command reruns Quartus II timing analysis with a global fMAX requirement 
of 100 MHz and saves the result in a file called timing_result-100.tao. By specifying 
the --write_settings_files=off option, the command-line executable does not 
update the Quartus II Settings File to reflect the changed fMAX requirement. The 
compiler database files reflect the changed fMAX requirement. If the 
--write_settings_files=off option is not specified, the command-line 
executable updates the Quartus II Settings File to reflect the 100-MHz global fMAX 
requirement.

Use the options --read_settings_files=off and 
--write_settings_files=off (where appropriate) to optimize the way that the 
Quartus II software reads and updates settings files. Example 2–4 shows how to avoid 
unnecessary reading and writing.

The quartus_tan and quartus_asm executables do not read or write settings files 
because they do not change any settings in the project.

Table 2–3. Location for Writing Assignments

Option Specified Location for Writing Assignments

--write_settings_files = on 
(Default)

Quartus II Settings File and compiler database

--write_settings_files = off Compiler database

Example 2–3. Write Settings Files

quartus_fit fir_filter --fmax=80MHz r 
quartus_tan fir_filter r 
quartus_tan fir_filter --fmax=100MHz --tao=timing_result-100.tao

--write_settings_files=off r 

Example 2–4. Avoiding Unnecessary Reading and Writing

quartus_map filtref --source=filtref --part=EP1C12F256C6 r 
quartus_fit filtref --fmax=100MHz --read_settings_files=off r 
quartus_tan filtref --read_settings_files=off --write_settings_files=off r 
quartus_asm filtref --read_settings_files=off --write_settings_files=off r 
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Design Flow
Figure 2–2 shows a typical design flow.

Compilation with quartus_sh --flow
Use the quartus_sh executable with the --flow option to perform a complete 
compilation flow with a single command. (For information about specialized flows, 
type quartus_sh --help=flow r at a command prompt.) The --flow option 
supports the smart recompile feature and efficiently sets command-line arguments for 
each executable in the flow. 

1 If you used the quartus_cmd executable to perform command-line compilations in 
earlier versions of the Quartus II software, you should use the quartus_sh --flow 
command beginning with the Quartus II software version 3.0. 

The following example runs compilation, timing analysis, and programming file 
generation with a single command:

quartus_sh --flow compile filtref r 

Text-Based Report Files
Each command-line executable creates a text report file when it is run. These files 
report success or failure, and contain information about the processing performed by 
the executable.

Figure 2–2. Typical Design Flow
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Report file names contain the revision name and the short-form name of the 
executable that generated the report file: <revision>.<executable>.rpt. For example, 
using the quartus_fit executable to place and route a project with the revision 
name design_top generates a report file named design_top.fit.rpt. Similarly, using 
the quartus_tan executable to perform timing analysis on a project with the 
revision name fir_filter generates a report file named fir_filter.tan.rpt.

As an alternative to parsing text-based report files, you can use the Tcl package called 
::quartus::report. For more information about this package, refer to “Command-Line 
Scripting Help” on page 2–5.

You can use Quartus II command-line executables in scripts that control a design flow 
that uses other software in addition to the Quartus II software. For example, if your 
design flow uses other synthesis or simulation software, and you can run the other 
software at a system command prompt, you can include it in a single script. The 
Quartus II command-line executables include options for common global project 
settings and operations, but you must use a Tcl script or the Quartus II GUI to set up a 
new project and apply individual constraints, such as pin location assignments and 
timing requirements. Command-line executables are very useful for working with 
existing projects, for making common global settings, and for performing common 
operations. For more flexibility in a flow, use a Tcl script, which makes it easier to pass 
data between different stages of the design flow and have more control during the 
flow. 

f For more information about Tcl scripts, refer to the Tcl Scripting chapter in volume 2 of 
the Quartus II Handbook, or the Quartus II Scripting Reference Manual.

For example, your script could run other synthesis software, then place-and-route the 
design in the Quartus II software, then generate output netlists for other simulation 
software. Example 2–5 shows how to do this with a UNIX shell script for a design that 
targets a Cyclone II device.

Example 2–5. Script for End-to-End Flow (Part 1 of 2)

#!/bin/sh
# Run synthesis first.
# This example assumes you use Synplify software
synplify -batch synthesize.tcl

# If your Quartus II project exists already, you can just
# recompile the design.
# You can also use the script described in a later example to
# create a new project from scratch
quartus_sh --flow compile myproject

# Use the quartus_tan executable to do best and worst case
# timing analysis
quartus_tan myproject --tao=worst_case
quartus_tan myproject --fast_model --tao=best_case

# Use the quartus_eda executable to write out a gate-level
# Verilog simulation netlist for ModelSim
quartus_eda my_project --simulation --tool=modelsim --format=verilog
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Makefile Implementation
You can use the Quartus II command-line executables in conjunction with the make 
utility to automatically update files when other files they depend on change. The file 
dependencies and commands used to update files are specified in a text file called a 
makefile.

To facilitate easier development of efficient makefiles, the following “smart action” 
scripting command is provided with the Quartus II software:

quartus_sh --determine_smart_action r
Because assignments for a Quartus II project are stored in the Quartus II Settings File 
(.qsf), including it in every rule results in unnecessary processing steps. For example, 
updating a setting related to programming file generation (which requires re-running 
only quartus_asm) modifies the Quartus II Settings File, requiring a complete 
recompilation if the Quartus II Settings File is included in every rule.

The smart action command determines the earliest command-line executable in the 
compilation flow that must be run based on the current Quartus II Settings File, and 
generates a change file corresponding to that executable. For a given command-line 
executable named quartus_<executable>, the change file is named with the format 
<executable>.chg. For example, if quartus_map must be re-run, the smart action 
command creates or updates a file named map.chg. Thus, rather than including the 
Quartus II Settings File in each makefile rule, include only the appropriate change file.

Example 2–6 uses change files and the smart action command. You can copy and 
modify it for your own use. A copy of this example is included in the help for the 
makefile option, which is available by typing:

quartus_sh --help=makefiles r

# Perform the simulation with the ModelSim software
vlib cycloneii_ver
vlog -work cycloneii_ver /opt/quartusii/eda/sim_lib/cycloneii_atoms.v
vlib work
vlog -work work my_project.vo
vsim -L cycloneii_ver -t 1ps work.my_project

Example 2–5. Script for End-to-End Flow (Part 2 of 2)

Example 2–6. Sample Makefile (Part 1 of 2)

###################################################################
# Project Configuration: 
# 
# Specify the name of the design (project), the Quartus II Settings
# File (.qsf), and the list of source files used.
###################################################################

PROJECT = chiptrip
SOURCE_FILES = auto_max.v chiptrip.v speed_ch.v tick_cnt.v time_cnt.v
ASSIGNMENT_FILES = chiptrip.qpf chiptrip.qsf 

###################################################################
# Main Targets
#
# all: build everything
# clean: remove output files and database
###################################################################
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all: smart.log $(PROJECT).asm.rpt $(PROJECT).tan.rpt 

clean:
rm -rf *.rpt *.chg smart.log *.htm *.eqn *.pin *.sof *.pof db

map: smart.log $(PROJECT).map.rpt
fit: smart.log $(PROJECT).fit.rpt
asm: smart.log $(PROJECT).asm.rpt
tan: smart.log $(PROJECT).tan.rpt
smart: smart.log

###################################################################
# Executable Configuration
###################################################################

MAP_ARGS = --family=Stratix
FIT_ARGS = --part=EP1S20F484C6
ASM_ARGS =
TAN_ARGS =

###################################################################
# Target implementations
###################################################################

STAMP = echo done >

$(PROJECT).map.rpt: map.chg $(SOURCE_FILES) 
quartus_map $(MAP_ARGS) $(PROJECT)
$(STAMP) fit.chg

$(PROJECT).fit.rpt: fit.chg $(PROJECT).map.rpt
quartus_fit $(FIT_ARGS) $(PROJECT)
$(STAMP) asm.chg
$(STAMP) tan.chg

$(PROJECT).asm.rpt: asm.chg $(PROJECT).fit.rpt
quartus_asm $(ASM_ARGS) $(PROJECT)

$(PROJECT).tan.rpt: tan.chg $(PROJECT).fit.rpt
quartus_tan $(TAN_ARGS) $(PROJECT) 

smart.log: $(ASSIGNMENT_FILES)
quartus_sh --determine_smart_action $(PROJECT) > smart.log

###################################################################
# Project initialization
###################################################################

$(ASSIGNMENT_FILES):
quartus_sh --prepare $(PROJECT)

map.chg:
$(STAMP) map.chg

fit.chg:
$(STAMP) fit.chg

tan.chg:
$(STAMP) tan.chg

asm.chg:
$(STAMP) asm.chg

Example 2–6. Sample Makefile (Part 2 of 2)
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A Tcl script is provided with the Quartus II software to create or modify files that can 
be specified as dependencies in the make rules, assisting you in makefile 
development. Complete information about this Tcl script and how to integrate it with 
makefiles is available by running the following command:

quartus_sh --help=determine_smart_action r

The MegaWizard Plug-In Manager
The MegaWizard™ Plug-In Manager and associated MegaWizard Plug-Ins provide a 
GUI-based flow to configure variation files. However, you can use command-line 
options to modify, update, or create variation files without using the GUI. This 
capability is useful in a fully scripted design flow, or in cases where you want to 
generate variation files without using the wizard GUI flow.

The MegaWizard Plug-In Manager has three functions: 

■ Providing an interface for you to select the output file or files

■ Running a specific MegaWizard Plug-In 

■ Creating output files (such as variation files, symbol files, and simulation netlist 
files)

Each MegaWizard Plug-In provides a user interface you use to configure the Plug-In 
variation, and performs validation and error-checking of your selected ports and 
parameters.

When you create or update a Plug-In variation in the GUI, the parameters and values 
are entered through the GUI provided by the Plug-In. The he Plug-In Manager then 
generates the required files. When you create a Plug-In variation with the command 
line, you provide the parameters and values as command-line options.

The MegaWizard Plug-In Manager command-line executable is qmegawiz. 
Example 2–7 shows how to create a new variation file.

When you use qmegawiz to update an existing variation file, the module or wizard 
name is not required.

If a megafunction changes between software version, the variation files must be 
updated. To do this, run qmegawiz -silent <variation file name>.

Table 2–4 describes the supported options.

Example 2–7. MegaWizard Plug-In Manager Command-Line Executable

qmegawiz [options] [module=<module name>|wizard=<wizard name>] [<param>=<value> ... 
<port>=<used|unused> ...] [OPTIONAL_FILES=<optional files>] <variation file name>

Table 2–4. qmegawiz Options

Option Description

-silent Run the MegaWizard Plug-In Manager in command-line mode, without displaying the 
GUI.

-f:<param file> A file that contains all options for the qmegawiz command. Refer to “Parameter File” 
on page 2–18.

-p:<working directory> Sets the default working directory. Refer to“Working Directory” on page 2–18.
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization



2–14 Chapter 2: Command-Line Scripting
The MegaWizard Plug-In Manager
Refer to “Module and Wizard Names” on page 2–15 for information about specifying 
the module name or wizard name.

Refer to “Ports and Parameters” on page 2–15 for information about specifying ports 
and parameters.

Refer to “Optional Files” on page 2–16 for information about generating optional files.

Refer to “Variation File Name” on page 2–18 for information about specifying the 
variation file name.

Command-Line Support
Only the MegaWizard Plug-Ins listed in Table 2–5 support creation and update with 
the command-line mode. For Plug-Ins not listed in the table, you must use the 
MegaWizard Plug-In Manager GUI for creation and update.

Table 2–5. MegaWizard Plug-Ins with Command Line Support (Part 1 of 2)

MegaWizard Plug-In Wizard Name Module Name

alt2gxb ALT2GXB alt2gxb

alt4gxb ALTGX alt4gxb

altclkctrl ALTCLKCTRL altclkctrl

altddio_bidir ALTDDIO_BIDIR altddio_bidir

altddio_in ALTDDIO_IN altddio_in

altddio_out ALTDDIO_OUT altddio_out

altecc_decoder
ALTECC

altecc_decoder

altecc_encoder altecc_encoder

altfp_add_sub ALTFP_ADD_SUB altfp_add_sub

altfp_compare ALTFP_COMPARE altfp_compare

altfp_convert ALTFP_CONVERT altfp_convert

altfp_div ALTFP_DIV altfp_div

altfp_mult ALTFP_MULT altfp_mult

altfp_sqrt ALTFP_SQRT altfp_sqrt

altiobuf_bidir

ALTIOBUF

altiobuf_bidir

altiobuf_in altiobuf_in

altiobuf_out altiobuf_out

altlvds_rx
ALTLVDS

altlvds_rx

altlvds_tx altlvds_tx

altmult_accum ALTMULT_ACCUM (MAC) altmult_accum

altmult_complex ALTMULT_COMPLEX altmult_complex

altpll_reconfig ALTPLL_RECONFIG altpll_reconfig

altpll ALTPLL altpll

altsyncram

RAM: 2-PORT

altsyncramRAM: 1-PORT

ROM: 1-PORT
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Module and Wizard Names
You must specify the wizard or module name, shown in Table 2–5, as a command-line 
option when you create a variation file. Use the option module=<module name> to 
specify the module, or use the option wizard=<wizard name> to specify the 
wizard. If there are spaces in the wizard or module name, enclose the name in double 
quotes, for example:

wizard="RAM: 2-PORT"

When there is a one-to-one mapping between the MegaWizard Plug-In and the 
wizard name and the module name, you can use either the wizard option or the 
module option. 

When there are multiple wizard names that correspond to one module name, you 
should use the wizard option to specify one wizard. 

When there are multiple module names that correspond to one wizard name, you 
should use the module option to specify one module. For example, use the module 
option if you create a FIFO because one wizard is common to both modules. However, 
you should use the wizard option if you create a RAM, because one module is 
common to three wizards.

If you edit or update an existing variation file, the wizard or module option is not 
necessary, because information about the wizard or module is already in the variation 
file.

Ports and Parameters
Ports and parameters for each MegaWizard Plug-In are described in Quartus II Help, 
and in the Megafunction User Guides on Altera’s website. You should use these 
references to determine appropriate values for each port and parameter required for a 
particular variation configuration. Refer to “Strategies to Determine Port and 
Parameter Values” for more information. You do not have to specify every port and 
parameter supported by a Plug-In. The MegaWizard Plug-In Manager uses default 
values for any port or parameter you do not specify.

Specify ports as used or unused, for example: 

<port>=used 
<port>=unused

You can specify port names in any order. Grouping does not matter. Separate port 
configuration options from each other with spaces. 

Specify a value for a parameter with the equal sign, for example:

<parameter>=<value>

You can specify parameters in any order. Grouping does not matter. Separate 
parameter configuration options from each other with spaces. You can specify port 
names and parameter names in upper or lower case; case does not matter.

dcfifo
FIFO

dcfifo

scfifo scfifo

Table 2–5. MegaWizard Plug-Ins with Command Line Support (Part 2 of 2)

MegaWizard Plug-In Wizard Name Module Name
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All MegaWizard Plug-Ins allow you to specify the target device family with the 
INTENDED_DEVICE_FAMILY parameter as shown in the following example:

qmegawiz wizard=<wizard> INTENDED_DEVICE_FAMILY="Cyclone III" <file>

You must specify enough ports and parameters to create a legal configuration of the 
Plug-In. When you use the GUI flow, each MegaWizard Plug-In performs validation 
and error checking for the particular ports and parameters you choose. When you use 
command-line options to specify ports and parameters, you must ensure that the 
ports and parameters you use are complete and valid for your particular 
configuration. 

For example, when you use a RAM Plug-In to configure a RAM to be 32 words deep, 
the Plug-In automatically configures an address port that is five bits wide. If you use 
the command-line flow to configure a RAM that is 32 words deep, you must use one 
option to specify the depth of the RAM, then calculate the width of the address port 
and specify that width with another option.

Invalid Configurations
If the combination of default and specified ports and parameters is not complete to 
create a legal configuration of the Plug-In, qmegawiz generates an error message that 
indicates what is missing and what values are supported. If the combination of 
default and specified ports and parameters results in an illegal configuration of the 
Plug-In, qmegawiz generates an error message that indicates what is illegal, and 
displays the legal values.

Strategies to Determine Port and Parameter Values
For simple Plug-In variations, it is often easy to determine appropriate port and 
parameter values with the information in Help and the Megafunction User Guides. 
Determining that a 32-word-deep RAM requires an address port that is five bits wide 
is straightforward. For complex Plug-In variations, an option in the GUI may affect 
multiple port and parameter settings, so it can be difficult to determine a complete set 
of ports and parameters. In this case, you should use the GUI to generate a variation 
file which includes the ports and parameters for your desired configuration. Open the 
variation file in a text editor and use the port and parameter values in the variation 
file as command-line options.

Optional Files
In addition to the variation file, the MegaWizard Plug-In Manager can generate other 
files, such as instantiation templates, simulation netlists, and symbols for graphic 
design entry. Use the OPTIONAL_FILES parameter to control whether the 
MegaWizard Plug-In Manager generates optional files. Table 2–6 lists valid arguments 
for the OPTIONAL_FILES parameter.

Table 2–6. Arguments for the OPTIONAL_FILES Parameter (Part 1 of 2)

Argument Description

INST Controls the generation of the <variation>_inst.v file.

INC Controls the generation of the <variation>.inc file.

CMP Controls the generation of the <variation>.cmp file.

BSF Controls the generation of the <variation>.bsf file.
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Specify a single optional file, for example: 

OPTIONAL_FILES=<argument>

Specify multiple optional files separated by a vertical bar character, for example:

OPTIONAL_FILES=<argument 1>|...|<argument n>

If you prefix an argument with a dash (for example, -BB), it is excluded from the 
generated optional files. If any of the optional files exist when you run qmegawiz and 
they are excluded in the OPTIONAL_FILES parameter (with the NONE argument, or 
prefixed with a dash), they are deleted.

You can combine the ALL argument with other excluded arguments to generate “all 
files except <excluded files>.” You can combine the NONE argument with other 
included arguments to generate “no files except <files>.” 

When you combine multiple arguments, they are processed from left to right, and 
arguments evaluated later have precedence over arguments evaluated earlier. 
Therefore, the ALL or NONE argument should be the first one in a combination of 
multiple arguments. When ALL is the first argument, all optional files are generated 
before exclusions are processed (deleted). When NONE is the first argument, none of 
the optional files are generated (in other words, any that exist are deleted), then any 
you specify are generated.

Table 2–7 shows examples for the OPTIONAL_FILES parameter and describes the 
result of each example.

BB Controls the generation of the <variation>_bb.v file.

SIM_NETLIST Controls the generation of simulation netlist file, wherever there is wizard support.

SYNTH_NETLIST Controls the generation of the synthesis netlist file, wherever there is wizard support.

ALL Generates all applicable optional files.

NONE Disables the generation of all optional files.

Table 2–6. Arguments for the OPTIONAL_FILES Parameter (Part 2 of 2)

Argument Description

Table 2–7. Examples of Different Optional File Arguments

Example Values for 
OPTIONAL_FILES Description

BB The optional file <variation>_bb.v is generated, and no optional files are deleted

BB|INST The optional file <variation>_bb.v is generated, then the optional file <variation>_inst.v is 
generated, and no optional files are deleted.

NONE No optional files are generated, and any existing optional files are deleted.

NONE|INC|BSF Any existing optional files are deleted, then the optional file <variation>.inc is generated, then 
the optional file <variation>.bsf is generated.

ALL|-INST All optional files are generated, then <variation>_inst.v is deleted if it exists.

-BB The optional file <variation>_bb.v is deleted if it exists

-BB|INST The optional file <variation>_bb.v is deleted if it exists, then the optional file <variation>_inst.v 
is generated.
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The qmegawiz command accepts the ALL argument combined with other included 
file arguments, for example, ALL|BB, but that combination is equivalent to ALL 
because first all optional files are generated, then the file <variation>_bb.v is 
generated (again). Additionally, the software accepts the NONE argument combined 
with other excluded file arguments, for example, NONE|-BB, but that combination is 
equivalent to NONE because no optional files are generated (any that exist are deleted), 
then the file <variation>_bb.v is deleted if it exists.

Parameter File
You can put all the parameter values and port values in a file, and pass the file name 
as an argument to qmegawiz with the -f:<parameter file> option. For example, you 
could run the following command:

qmegawiz -silent module=altsyncram -f:rom_params.txt myrom.v r 
The following options are in a file called rom_params.txt:

RAM_BLOCK_TYPE=M4K DEVICE_FAMILY=Stratix WIDTH_A=5 WIDTHAD_A=5 
NUMWORDS_A=32 INIT_FILE=rom.hex OPERATION_MODE=ROM

Working Directory
You can change the working directory that qmegawiz uses when it generates files. By 
default, the working directory is the current directory when you execute the 
qmegawiz command. Use the -p option to specify a different working directory, for 
example:

-p:<working directory>

You can specify the working directory with an absolute or relative path. Specify an 
alternative working directory any time you do not want files generated in the current 
directory. The alternative working directory can be useful if you generate multiple 
variations in a batch script, and keep generated files for the different Plug-In 
variations in separate directories.

Variation File Name
The language used for a variation file depends on the file extension of the variation 
file name. The MegaWizard Plug-In Manager creates HDL output files in a language 
based on the file name extension. Therefore, you must always specify a complete file 
name, including file extension, as the last argument to the qmegawiz command. 
Table 2–8 shows the file extension that corresponds to supported HDL types.

Table 2–8. Variation File Extensions

Variation File HDL Type Required File Extension

Verilog HDL .v

VHDL .vhd

AHDL .tdf
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Command-Line Scripting Examples
This section of the chapter presents various examples of command-line executable 
use.

Create a Project and Apply Constraints
The command-line executables include options for common global project settings 
and commands. To apply constraints such as pin locations and timing assignments, 
run a Tcl script with the constraints in it. You can write a Tcl constraint file from 
scratch, or generate one for an existing project. From the Project menu, click Generate 
Tcl File for Project.

Example 2–8 creates a project with a Tcl script and applies project constraints using 
the tutorial design files in the <Quartus II installation directory>/qdesigns/fir_filter/ 
directory.

Save the script in a file called setup_proj.tcl and type the commands illustrated in 
Example 2–9 at a command prompt to create the design, apply constraints, compile 
the design, and perform fast-corner and slow-corner timing analysis. Timing analysis 
results are saved in two files.

You can use the following two commands to create the design, apply constraints, and 
compile the design:

quartus_sh -t setup_proj.tcl r
quartus_sh --flow compile filtref r
The quartus_sh --flow compile command performs a full compilation, and is 
equivalent to clicking the Start Compilation button in the toolbar. 

Example 2–8. Tcl Script to Create Project and Apply Constraints

project_new filtref -overwrite
# Assign family, device, and top-level file
set_global_assignment -name FAMILY Cyclone 
set_global_assignment -name DEVICE EP1C12F256C6 
set_global_assignment -name BDF_FILE filtref.bdf 
# Assign pins
set_location_assignment -to clk Pin_28 
set_location_assignment -to clkx2 Pin_29 
set_location_assignment -to d[0] Pin_139 
set_location_assignment -to d[1] Pin_140 
# Other pin assignments could follow 
# Create timing assignments 
create_base_clock -fmax "100 MHz" -target clk clocka 
create_relative_clock -base_clock clocka -divide 2 -offset "500 ps" -target clkx2 clockb
set_multicycle_assignment -from clk -to clkx2 2 
# Other timing assignments could follow 
project_close

Example 2–9. Script to Create and Compile a Project

quartus_sh -t setup_proj.tcl r
quartus_map filtref r
quartus_fit filtref r
quartus_asm filtref r
quartus_tan filtref --fast_model --tao=min.tao --export_settings=off r
quartus_tan filtref --tao=max.tao --export_settings=off r
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Check Design File Syntax
The UNIX shell script example shown in Example 2–10 assumes that the Quartus II 
software fir_filter tutorial project exists in the current directory. (You can find the 
fir_filter project in the <Quartus II directory>/qdesigns/fir_filter directory unless the 
Quartus II software tutorial files are not installed.)

The --analyze_file option performs a syntax check on each file. The script checks 
the exit code of the quartus_map executable to determine whether there is an error 
during the syntax check. Files with syntax errors are added to the 
FILES_WITH_ERRORS variable, and when all files are checked, the script prints a 
message indicating syntax errors. When options are not specified, the executable uses 
the project database values. If not specified in the project database, the executable uses 
the Quartus II software default values. For example, the fir_filter project is set to 
target the Cyclone device family, so it is not necessary to specify the --family 
option.

Create a Project and Synthesize a Netlist Using Netlist Optimizations
This example creates a new Quartus II project with a file top.edf as the top-level 
entity. The --enable_register_retiming=on and 
--enable_wysiwyg_resynthesis=on options allow the technology mapper to 
optimize the design using gate-level register retiming and technology remapping.

f For more details about register retiming, WYSIWYG primitive resynthesis, and other 
netlist optimization options, refer to the Quartus II Help.

The --part option tells the technology mapper to target an EP20K600EBC652-1X 
device. To create the project and synthesize it using the netlist optimizations described 
above, type the command shown in Example 2–11 at a command prompt.

Example 2–10. Shell Script to Check Design File Syntax

#!/bin/sh
FILES_WITH_ERRORS=""
# Iterate over each file with a .bdf or .v extension
for filename in `ls *.bdf *.v`
do
# Perform a syntax check on the specified file

quartus_map fir_filter --analyze_file=$filename
# If the exit code is non-zero, the file has a syntax error
if [ $? -ne 0 ]
then

FILES_WITH_ERRORS="$FILES_WITH_ERRORS $filename"
fi

done
if [ -z "$FILES_WITH_ERRORS" ]
then

echo "All files passed the syntax check"
exit 0

else
echo "There were syntax errors in the following file(s)"
echo $FILES_WITH_ERRORS
exit 1

fi
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Archive and Restore Projects
You can archive or restore a Quartus II project with a single command. This makes it 
easy to take snapshots of projects when you use batch files or shell scripts for 
compilation and project management. Use the --archive or --restore options for 
quartus_sh as appropriate. Type the command shown in Example 2–12 at a system 
command prompt to archive your project.

The archive file is automatically named <project name>.qar. If you want to use a 
different name, rename the archive after it has been created. This command 
overwrites any existing archive with the same name.

To restore a project archive, type the command shown in Example 2–13 at a system 
command prompt.

The command restores the project archive to the current directory and overwrites 
existing files.

Perform I/O Assignment Analysis
You can perform I/O assignment analysis with a single command. I/O assignment 
analysis checks pin assignments to ensure they do not violate board layout guidelines. 
I/O assignment analysis does not require a complete place and route, so it is a quick 
way to ensure your pin assignments are correct. The command shown in 
Example 2–14 performs I/O assignment analysis for the specified project and 
revision.

Update Memory Contents without Recompiling
You can use two simple commands to update the contents of memory blocks in your 
design without recompiling. Use the quartus_cdb executable with the 
--update_mif option to update memory contents from Memory Initialization Files 
or Hexadecimal (Intel-Format) Files. Then re-run the assembler with the 
quartus_asm executable to regenerate the SOF, POF, and any other programming 
files.

Example 2–11. Creating a Project and Synthesizing a Netlist Using Netlist Optimizations

quartus_map top --source=top.edf --enable_register_retiming=on
--enable_wysiwyg_resynthesis=on --part=EP20K600EBC652-1X r 

Example 2–12. Archiving a Project

quartus_sh --archive <project name> r

Example 2–13. Restoring a Project Archive

quartus_sh --restore <archive name> r

Example 2–14. Performing I/O Assignment Analysis

quartus_fit --check_ios <project name> --rev=<revision name> r
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Example 2–15 shows these two commands.

Example 2–16 shows the commands for a DOS batch file for this example. You can 
paste the following lines into a DOS batch file called update_memory.bat.

Type the following command at a system command prompt:

update_memory.bat <project name> <revision name> r

Create a Compressed Configuration File
You can create a compressed configuration file in two ways. The first way is to run 
quartus_cpf with an option file that turns on compression. The second way is to 
run quartus_cpf with a Conversion Setup File (.cof).

To create an option file that turns on compression, type 

quartus_cpf -w <filename>.opt r
This interactive command walks you through some questions, including 
compression, then creates an option file based on your answers. Use the --option 
option to quartus_cpf to specify the option file you just created. For example, the 
following command creates a compressed Programming Object File (.pof) that targets 
an EPCS64 device:

quartus_cpf --convert --option=<filename>.opt --device=EPCS64 <file>.sof <file>.pof r
Alternatively, you can use the Convert Programming Files utility in the Quartus II 
software to create a conversion setup file. Configure any options you want, including 
compression, then save the conversion setup. Use the following command to run the 
conversion setup you specified: 

quartus_cpf <file>.cof r

Fit a Design as Quickly as Possible
This example assumes that a project called top exists in the current directory, and that 
the name of the top-level entity is top. The --effort=fast option causes the Fitter 
to use the fast fit algorithm to increase compilation speed, possibly at the expense of 
reduced fMAX performance. The --one_fit_attempt=on option restricts the Fitter 
to only one fitting attempt for the design.

To attempt to fit the project called top as quickly as possible, type the command 
shown in Example 2–17 at a command prompt.

Example 2–15. Commands to Update Memory Contents without Recompiling

quartus_cdb --update_mif <project name> [--rev=<revision name>]r
quartus_asm <project name> [--rev=<revision name>]r

Example 2–16. Batch file to Update Memory Contents without Recompiling

quartus_cdb --update_mif %1 --rev=%2
quartus_asm %1 --rev=%2

Example 2–17. Fitting a Project Quickly

quartus_fit top --effort=fast --one_fit_attempt=on r
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation



Chapter 2: Command-Line Scripting 2–23
Command-Line Scripting Examples
Fit a Design Using Multiple Seeds
This shell script example assumes that the Quartus II software tutorial project called 
fir_filter exists in the current directory (defined in the file fir_filter.qpf). If the tutorial 
files are installed on your system, this project exists in the <Quartus II 
directory>/qdesigns<quartus_version_number> /fir_filter directory. Because the 
top-level entity in the project does not have the same name as the project, you must 
specify the revision name for the top-level entity with the --rev option. The --seed 
option specifies the seeds to use for fitting.

A seed is a parameter that affects the random initial placement of the Quartus II Fitter. 
Varying the seed can result in better performance for some designs.

After each fitting attempt, the script creates new directories for the results of each 
fitting attempt and copies the complete project to the new directory so that the results 
are available for viewing and debugging after the script has completed.

Example 2–18 is designed for use on UNIX systems using sh (the shell).

1 Use the Design Space Explorer (DSE) included with the Quartus II software script (by 
typing quartus_sh --dse r at a command prompt) to improve design 
performance by performing automated seed sweeping. 

f For more information about the DSE, type quartus_sh --help=dse r at the 
command prompt, or refer to the Design Space Explorer chapter in volume 2 of the 
Quartus II Handbook, or see the Quartus II Help.

Example 2–18. Shell Script to Fit a Design Using Multiple Seeds

#!/bin/sh
ERROR_SEEDS=""
quartus_map fir_filter --rev=filtref
# Iterate over a number of seeds
for seed in 1 2 3 4 5
do
echo "Starting fit with seed=$seed"
# Perform a fitting attempt with the specified seed
quartus_fit fir_filter --seed=$seed --rev=filtref
# If the exit-code is non-zero, the fitting attempt was
# successful, so copy the project to a new directory
if [ $? -eq 0 ]
then

mkdir ../fir_filter-seed_$seed
mkdir ../fir_filter-seed_$seed/db
cp * ../fir_filter-seed_$seed
cp db/* ../fir_filter-seed_$seed/db

else
ERROR_SEEDS="$ERROR_SEEDS $seed"

fi
done
if [ -z "$ERROR_SEEDS" ]
then
echo "Seed sweeping was successful"
exit 0
else
echo "There were errors with the following seed(s)" 
echo $ERROR_SEEDS
exit 1
fi
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A Tcl/Tk-based graphical interface called QFlow is included with the command-line 
executables. You can use the QFlow interface to open projects, launch some of the 
command-line executables, view report files, and make some global project 
assignments. The QFlow interface can run the following command-line executables:

■ quartus_map (Analysis and Synthesis)

■ quartus_fit (Fitter)

■ quartus_tan (Timing Analysis)

■ quartus_asm (Assembler)

■ quartus_eda (EDA Netlist Writer)

To view floorplans or perform other GUI-intensive tasks, launch the Quartus II 
software.

Start QFlow by typing the following command at a command prompt: 

quartus_sh -g r 
Figure 2–3 shows the QFlow interface.

1 The QFlow script is located in the <Quartus II directory>/common/tcl/apps/qflow/ 
directory.

Referenced Documents
This chapter references the following documents:

■ Design Space Explorer chapter in volume 2 of the Quartus II Handbook

■ Quartus II Scripting Reference Manual

■ Quartus II Settings File Reference Manual

■ Tcl Scripting chapter in volume 2 of the Quartus II Handbook

Figure 2–3. QFlow Interface
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Table 2–9 shows the revision history for this chapter.

f For previous versions of the Quartus II Handbook, refer to the Quartus II Handbook 
Archive.

Table 2–9. Document Revision History 

Date / Version Changes Made Summary of Changes

March 2009,
v9.0.0

No change to content. Updated for the Quartus II 
software version 9.0 release.

November 2008,
v8.1.0

Added the following sections:

■ “The MegaWizard Plug-In Manager” on page 2–13

■ “Command-Line Support” on page 2–14

■ “Module and Wizard Names” on page 2–15

■ “Ports and Parameters” on page 2–15

■ “Invalid Configurations” on page 2–16

■ “Strategies to Determine Port and Parameter Values” on 
page 2–16

■ “Optional Files” on page 2–16

■ “Parameter File” on page 2–18

■ “Working Directory” on page 2–18

■ “Variation File Name” on page 2–18

■ “Create a Compressed Configuration File” on page 2–22

Updated “Option Precedence” on page 2–7 to clarify how to 
control precedence

Corrected Example 2–5 on page 2–10

Changed Example 2–1, Example 2–2, Example 2–4, and 
Example 2–7 to use the EP1C12F256C6 device

Minor editorial updates

Updated entire chapter using 8½” × 11” chapter template

Updated for the Quartus II 
software version 8.1 release.

May 2008,
v8.0.0

Updated “Referenced Documents” on page 2–20.

Updated references in document.

Updated for the Quartus II 
software version 8.0.
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3. Tcl Scripting
Introduction
Developing and running Tcl scripts to control the Altera® Quartus® II software allows 
you to perform a wide range of functions, such as compiling a design or writing 
procedures to automate common tasks.

You can use Tcl scripts to manage a Quartus II project, make assignments, define 
design constraints, make device assignments, run compilations, perform timing 
analysis, import LogicLock™ region assignments, use the Quartus II Chip Editor, and 
access reports. You can automate your Quartus II assignments using Tcl scripts so that 
you do not have to create them individually. Tcl scripts also facilitate project or 
assignment migration. For example, when using the same prototype or development 
board for different projects, you can automate reassignment of pin locations in each 
new project. The Quartus II software can also generate a Tcl script based on all the 
current assignments in the project, which aids in switching assignments to another 
project.

The Quartus II software Tcl commands follow the EDA industry Tcl application 
programming interface (API) standards for using command-line options to specify 
arguments. This simplifies learning and using Tcl commands. If you encounter an 
error using a command argument, the Tcl interpreter gives help information showing 
correct usage.

This chapter includes sample Tcl scripts for automating the Quartus II software. You 
can modify these example scripts for use with your own designs. You can find more 
Tcl scripts in the Design Examples section of the Support area of Altera’s website.

This chapter includes the following topics:

■ “Quartus II Tcl Packages” on page 3–2

■ “Quartus II Tcl API Help” on page 3–4

■ “Executables Supporting Tcl” on page 3–7

■ “End-to-End Design Flows” on page 3–9

■ “Creating Projects and Making Assignments” on page 3–10

■ “Compiling Designs” on page 3–14

■ “Reporting” on page 3–15

■ “Timing Analysis” on page 3–18

■ “Automating Script Execution” on page 3–22

■ “Other Scripting Features” on page 3–25

■ “Using the Quartus II Tcl Shell in Interactive Mode” on page 3–29

■ “Quartus II Legacy Tcl Support” on page 3–32

■ “Using the tclsh Shell” on page 3–32 

■ “Tcl Scripting Basics” on page 3–33
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What is Tcl?
Tcl (pronounced “tickle”) is a popular scripting language that is similar to many shell 
scripting and high-level programming languages. It provides support for control 
structures, variables, network socket access, and APIs. Tcl is the EDA 
industry-standard scripting language used by Synopsys, Mentor Graphics®, and 
Altera software. It allows you to create custom commands and works seamlessly 
across most development platforms. For a list of recommended literature on Tcl, refer 
to “External References” on page 3–39.

You can create your own procedures by writing scripts containing basic Tcl 
commands, user-defined procedures, and Quartus II API functions. You can then 
automate your design flow, run the Quartus II software in batch mode, or execute the 
individual Tcl commands interactively in the Quartus II Tcl interactive shell.

If you’re unfamiliar with Tcl scripting, or are a Tcl beginner, refer to “Tcl Scripting 
Basics” on page 3–33 for an introduction to Tcl scripting.

The Quartus II software, beginning with version 4.1, supports Tcl/Tk version 8.4, 
supplied by the Tcl DeveloperXchange at tcl.activestate.com.

Quartus II Tcl Packages
The Quartus II Tcl commands are grouped in packages by function. Table 3–1 
describes each Tcl package.

Table 3–1. Tcl Packages (Part 1 of 2)

Package Name Package Description

advanced_timing Traverse the timing netlist and get information about timing nodes

backannotate Back annotate assignments

chip_planner Identify and modify resource usage and routing with the Chip Editor

database_manager Manage version-compatible database files

device Get device and family information from the device database

flow Compile a project, run command-line executables and other common flows

insystem_memory_edit Read and edit memory contents in Altera devices

jtag Control the JTAG chain

logic_analyzer_interface Query and modify the logic analyzer interface output pin state

logiclock Create and manage LogicLock regions

misc Perform miscellaneous tasks

project Create and manage projects and revisions, make any project assignments including timing 
assignments

report Get information from report tables, create custom reports

sdc Specifies constraints and exceptions to the TimeQuest Timing Analyzer

simulator Configure and perform simulations

sta Contains the set of Tcl functions for obtaining advanced information from the Quartus II 
TimeQuest Timing Analyzer

stp Run the SignalTap® II Logic Analyzer

timing Annotate timing netlist with delay information, compute and report timing paths
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